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Chapter 1

About this Guide
This User's Guide provides information on how to prepare custom Virtual Analyzer
images in the following topics:

• OVA File Creation Using New Virtual Machine Images on page 2-1

• OVA File Creation Using Converted Virtual Hard Disk Drives on page 3-1

• Virtual Analyzer Image Preparation Tool on page 4-1
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Document Conventions
The documentation uses the following conventions:

Table 1-1. Document Conventions

Convention Description

UPPER CASE Acronyms, abbreviations, and names of certain
commands and keys on the keyboard

Bold Menus and menu commands, command buttons, tabs,
and options

Italics References to other documents

Monospace Sample command lines, program code, web URLs, file
names, and program output

Navigation > Path The navigation path to reach a particular screen

For example, File > Save means, click File and then click
Save on the interface

Note Configuration notes

Tip Recommendations or suggestions

Important Information regarding required or default configuration
settings and product limitations

WARNING! Critical actions and configuration options
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Audience
This User Guide is intended for administrators who need to create custom sandbox
images for Virtual Analyzer. The document assumes a working knowledge of networks
and information security, including the following topics:

• Deploying and administering Deep Discovery or TippingPoint products

• Using Oracle VM VirtualBox™ or VMware™ products

Terminology

Terminology Description

Open Virtual
Appliance (OVA)

A ready-to-use software package (operating system with
applications) that does not require additional configuration or
installation. Virtual Analyzer supports only image files in the Open
Virtual Appliance (OVA) format.

Sandbox image A template used to deploy sandbox instances in Virtual Analyzer.
A sandbox image includes an operating system, installed
software, and other settings necessary for that specific computing
environment.

Sandbox instance A single virtual machine based on a sandbox image.

Virtual Analyzer A secure virtual environment that manages and analyzes objects
submitted by integrated products and administrators. During
analysis, Virtual Analyzer rates the characteristics in context and
then assigns a risk level to the object based on the accumulated
ratings.

Virtual Analyzer
Sensors

A collection of utilities that execute and detect malware, and
record all behavior in Virtual Analyzer.

Virtual Machine Disk
(*.vmdk)

A file format used in virtual machines like VMware Workstation or
Oracle VM VirtualBox.
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Chapter 2

OVA File Creation Using New Virtual
Machine Images

Learn how to create a Virtual Analyzer-supported OVA file in the following topics:

• Downloading and Installing VirtualBox on page 2-5

• Creating Virtual Machine Images on page 2-7

• Modifying the Virtual Machine Environment on page 2-24

• Reducing the Size of VirtualBox Disk Images on page 2-32

• Exporting Virtual Machine Images to OVA Files on page 2-33
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Creating OVA Files Using New Virtual Machine
Images

Procedure

1. Prepare the operating system and required applications.

For details, see Required Software on page 2-2.

2. Download and install VirtualBox.

For details, see Downloading and Installing VirtualBox on page 2-5.

3. Create a virtual machine image.

For details, see Creating Virtual Machine Images on page 2-7.

4. Modify the environment of the virtual machine image.

For details, see Modifying the Virtual Machine Environment on page 2-24.

5. Reduce the size of the VirtualBox Disk Image.

For details, see Reducing the Size of VirtualBox Disk Images on page 2-32.

6. Export the virtual machine image to an OVA file.

For details, see Exporting Virtual Machine Images to OVA Files on page 2-33.

Required Software
The following software must be installed on the virtual machine to achieve satisfactory
detection results.
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Table 2-1. Required Applications

Software Description

Operating system Virtual Analyzer supports the following operating systems:

• Windows XP

• Windows 7

• Windows 8/8.1

• Windows 10 RS3 and before

• Windows Server 2003/2003 R2

• Windows Server 2008/2008 R2

• Windows Server 2012/2012 R2

• Windows Server 2016

Important

• Package the installer as an ISO file.

• Activate Windows with a valid product key after the
Virtual Analyzer Image Preparation Tool has validated
and modified virtual machine settings. Do not activate
Windows before that.

• Use a computer name that reflects your organizations'
naming scheme.

• Disable automatic updates.

• Trend Micro recommends using the English version of
the listed operating systems.
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Software Description

Office suite Virtual Analyzer supports the following office suites:

• Office 2003 (32-bit)

• Office 2007 (32-bit)

• Office 2010 (32-bit and 64-bit)

• Office 2013 (32-bit and 64-bit)

• Office 2016 (32-bit and 64-bit)

• Office 365 (32-bit and 64-bit)

Important

• Microsoft Word, Microsoft Excel, Microsoft PowerPoint,
and Microsoft Publisher must be installed.

• Activate Microsoft Office with a valid product key after
the Virtual Analyzer Image Preparation Tool has
validated and modified virtual machine settings. Do not
activate Microsoft Office before that.

• After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If
any confirmation dialog or welcome screen displays,
make any selection to close the screen and display the
main editing screen.

Figure 2-1. Help Protect and Improve Microsoft
Office

• Verify that your license allows you to virtualize the
applications. For details, see https://support.office.com.

• Disable automatic updates.

• Enable macros. For details, see Enable or disable
macros in Office files

https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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Software Description

Adobe Reader Install the version of Adobe Reader that is most widely used in
your organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

• Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

• Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

• Uses all versions during analysis.

WARNING!
This consumes additional computing resources.

• Installs .NET Framework 3.5 or later if the operating system
is Windows XP or Windows Server 2003.

Configure Adobe Reader to manually check for and install
updates. For details, see https://helpx.adobe.com/acrobat/kb/
reader-acrobat-updater-settings.html.

Important
Do not install VMware tools to avoid triggering the anti-virtual machine functions of some
malware.

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org/wiki/
Downloads.

http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
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Note
The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2. Configure the language settings using one of the following methods:

• Install VirtualBox with English as the default language.

• After installation, go to File > Preferences > Language and then select
English.

Figure 2-2. Language Settings

http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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Creating Virtual Machine Images

Procedure

1. Open VirtualBox.

The VirtualBox Manager window opens.

Figure 2-3. VirtualBox Manager

2. Click New.
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The Create Virtual Machine window opens.

Figure 2-4. Create Virtual Machine

3. On the Name and operating system screen, configure the following:

• Name: Type a permanent name for the virtual machine.

• Type: Select Microsoft Windows.

• Version: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 10, Windows 2008/2008 R2, Windows 2012/2012
R2 or Windows 2016.
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4. Click Next.

The Memory size screen appears.

Figure 2-5. Memory Size

5. Specify the recommended memory size for your operating system.

• Windows XP and Windows Server 2003: 512 MB

• Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: 1024 MB

6. Click Next.
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The Hard disk screen appears.

Figure 2-6. Hard Disk

7. Select Create a virtual hard disk now and then click Create.
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The Hard disk file type screen appears.

Figure 2-7. Hard Disk File Type

8. Select VDI (VirtualBox Disk Image) or VMDK (Virtual Machine Disk) and
then click Next.
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The Storage on physical hard disk screen appears.

Figure 2-8. Storage on Physical Hard Disk

9. Select Dynamically allocated and then click Next.

Important

Do not select Fixed size or Split into files of less than 2GB.
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The File location and size screen appears.

Figure 2-9. File Location and Size

10. (Optional) Click the folder icon to change the path of the virtual disk file.

11. Specify the virtual disk size for your operating system.

• Windows XP and Windows Server 2003: 15 GB
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• Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: 25 GB

Note

Trend Micro recommends specifying a larger virtual disk size if you intend to install
additional software.

12. Click Create.

VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane of the VirtualBox Manager screen.

Figure 2-10. Newly-created Virtual Machine

13. Click Settings.
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The Settings window opens.

Figure 2-11. VirtualBox Settings

14. In the left pane, click System.
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The System screen appears.

Figure 2-12. System Screen

15. On the Motherboard tab, configure the following:

• Chipset: Select ICH9

• Pointing Device: Select USB Tablet

• Extended Features: Select Enable I/O APIC

16. Go to the Processor tab and then select Enable PAE/NX.

17. Go to the Acceleration tab and then select Enable VT-x/AMD-V and Enable
Nested Paging.
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Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the
host system.

18. In the left pane, click Storage.

The Storage screen appears.

Figure 2-13. Storage Screen

19. If Controller: SATA appears under Storage Tree, remove the SATA controller
and then add the virtual hard drive to the IDE controller.

a. Click Controller: SATA and then click  to remove the default controller.

b. Click Controller: IDE and then click .
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The following message appears:

Figure 2-14. Choose Existing Disk

c. Click Choose existing disk and then select the virtual hard disk file that you
previously created.

d. Under Attributes, retain all default settings.

e. Under Storage Tree, click Controller: IDE and then click the empty optical
drive icon.

f. Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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Figure 2-15. IDE Secondary Master

20. Under Attributes, click , and then select Choose a virtual CD/DVD disk
file….

21. Select the ISO file containing the operating system installer.

The ISO file is available as a device.

22. (Optional) In the left pane, click Audio and verify that Enable Audio is enabled.
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Figure 2-16. Audio Options Settings

23. In the left pane, click USB and then select Enable USB Controller.

Important
Verify that USB 1.1 (OHCI) Controller is selected.
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Figure 2-17. Enable USB Controller

24. In the left pane, click Shared Folders and then verify that no folders are shared.
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Figure 2-18. Shared Folders Settings

25. Click OK.

The Settings window closes.

26. On the VirtualBox Manager screen, click  to power on the image.



  OVA File Creation Using New Virtual Machine Images

  2-23

Figure 2-19. VirtualBox Manager

The installation process starts.

27. Follow the on-screen instructions to install the guest operating system.
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Figure 2-20. Operating System Installation Process

28. Install Microsoft Office and other software to achieve satisfactory detection results.

Modifying the Virtual Machine Environment
Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.

• Modifying the Virtual Machine Environment (Windows XP and Windows Server 2003) on
page 2-25

• Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2 and Windows Server 2016) on page 2-27



  OVA File Creation Using New Virtual Machine Images

  2-25

Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1. Open a Command Prompt window (cmd.exe) using an account with
administrator privileges.

2. Perform the following tasks:

Task Steps

Set the "Administrator"
logon password to "1111".

Type net user "Administrator" 1111.

Configure automatic logon
from the “Administrator”
account.

Note
The logon prompt is
bypassed and the
“Administrator”
account is
automatically used
to log on to the
system every time
the virtual machine
starts.

a. Type the following commands:

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
REG_SZ /d Administrator /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_SZ /d 1111 /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v AutoAdminLogon /t
REG_SZ /d 1 /f

b. Restart the image.
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Task Steps

Note
No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

Figure 2-21. Windows XP Administrator
Account

View all user accounts. Type net user.

Delete non-built-in user
accounts one at a time.

Type net user “<username>” /delete.

Example: net user “test” /delete

View all network adapters
with an active link

Type wmic nic where "netconnectionstatus=2"
get netconnectionid /value.
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Task Steps
Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of
all installed network
adapters

Type netsh interface ip show config.

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. Type netsh firewall set opmode mode=DISABLE.

Note
Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

3. Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016)

Procedure

1. Open a Command Prompt window (cmd.exe) using an account with
administrator privileges.

2. Perform the following tasks:
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Task Steps

Enable the “Administrator”
account.

Type net user “Administrator” /active:yes.

Set the logon password
for the “Administrator”
account to “1111”.

Type net user "Administrator" 1111.

Configure automatic logon
from the administrator
account.

Note
Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”
account is
automatically used
to log on to the
system.

a. Type the following commands:

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
REG_SZ /d Administrator /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_SZ /d 1111 /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v AutoAdminLogon /t
REG_SZ /d 1 /f
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Task Steps

Note
In Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2 and
Windows Server 2016, launch the
Local Security Policy snap-in
(secpol.msc) to disable the Password
must meet complexity requirements
Local Security Setting.

Figure 2-22. Disable Password
must meet complexity requirements

• Restart the image.
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Task Steps
No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

Figure 2-23. Windows 7 Administrator
Account

View all user accounts. Type net user.

Delete non-built-in user
accounts one at a time.

Type net user “<username>” /delete.

Example: net user “test” /delete

View all network adapters
with an active link

Type wmic nic where "netconnectionstatus=2"
get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of
all installed network
adapters

Type netsh interface ip show config.
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Task Steps
The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Configure AutoPlay a. Open the Windows Start menu, type Control
Panel into the search box and press ENTER.

b. In the Control Panel, go to Hardware and Sound
> AutoPlay.

Figure 2-24. AutoPlay

c. For Software and games, select Install or run
program from your media.

d. Click Save.

Disable Windows Firewall. Type netsh advfirewall set allprofiles state
off.

Note
Windows Firewall slows down the installation of
Virtual Analyzer Sensors.
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3. Restart the virtual machine.

Reducing the Size of VirtualBox Disk Images

Procedure

1. Uninstall unnecessary applications and optional Windows components.

2. Run Disk Cleanup to free up space on the hard disk.

The utility searches for files and data that you can safely delete, including:

• Temporary Windows and Internet files

• ActiveX controls, Java applets, and other downloaded program files

• Files in the Recycle Bin

For details, see the Microsoft Help: http://windows.microsoft.com/en-us/
windows/delete-files-using-disk-cleanup#delete-files-using-disk-
cleanup=windows-7.

3. Use Deployment Image Servicing and Management (DISM) to free up space
on the hard disk.

DISM is a command-line utility that can be used to free up disk space by managing
the Windows Component Store (WinSxS directory).

For details, see the Microsoft Developer resource website: https://
msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/
desktop/clean-up-the-winsxs-folder

a. Open a Command Prompt window.

Note

Depending on the Windows version, not all of the following commands may be
supported.

b. Type dism /Online /Cleanup-Image /SPSuperseded.

http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
http://windows.microsoft.com/en-us/windows/delete-files-using-disk-cleanup#delete-files-using-disk-cleanup=windows-7
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
https://msdn.microsoft.com/en-us/windows/hardware/commercialize/manufacture/desktop/clean-up-the-winsxs-folder
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c. Type dism /Online /Cleanup-Image /StartComponentCleanup /
ResetBase.

4. Download SDelete and then zero out the free space on the hard disk.

SDelete is a free command-line utility that securely deletes existing files and
permanently erases file data in unallocated clusters of a disk. The utility can also
ensures that even encrypted files cannot be recovered by overwriting all addressable
locations with new and random characters.

a. Download sdelete.zip from the Windows Sysinternals website: https://
technet.microsoft.com/en-us/sysinternals/sdelete.aspx

b. Extract sdelete.exe.

c. Open a Command Prompt window.

d. Go to the folder that contains sdelete.exe.

e. Type sdelete -z [drive letter].

SDelete zeroes the free space on the hard disk.

5. Shut down the virtual machine.

6. Open a Command Prompt window on the host system.

7. Type "C:\Program Files\Oracle\VirtualBox\VBoxManage.exe"
modifyhd [path\[vm_name.vdi] --compact.

The virtual hard disk drive size is reduced.

Exporting Virtual Machine Images to OVA Files
A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.

Important
Verify that the size of the created OVA file is supported by your product.

For details, go to https://docs.trendmicro.com/en-us/home.aspx#Enterprise.

https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
https://technet.microsoft.com/en-us/sysinternals/sdelete.aspx
https://docs.trendmicro.com/en-us/home.aspx#Enterprise
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Procedure

1. On the VirtualBox Manager screen, power off the virtual machine.

Note

Verify that the CD/DVD drive is empty before powering off and exporting.

2. Go to File > Export Appliance.

The Export Virtual Appliance window appears.

Figure 2-25. Export Virtual Appliance

3. Select the virtual machine image to export and click Next.
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The Storage settings screen appears.

Figure 2-26. Storage settings

4. Configure the following:

• File: Accept the default name and path or click  to select a different file.

• Format: Select OVF 1.0.

Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.

5. Click Next.
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The Appliance settings screen appears.

Figure 2-27. Appliance settings

6. Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

Figure 2-28. Disk Image Export Progress Bar
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Chapter 3

OVA File Creation Using Converted
Virtual Hard Disk Drives

Learn how to prepare and import an OVA file in the following topics:

• Modifying the Virtual Machine Environment on page 3-6

• Exporting Virtual Machine Images on page 3-16

• Converting VMware ESXi Virtual Hard Disk Drives on page 3-23

• Creating Virtual Machine Images Using Converted Virtual Hard Disk Drives on page 3-30

• Configuring Virtual Machine Images on page 3-46

• Exporting Virtual Machine Images to OVA Files on page 3-51
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Creating OVA Files Using Converted Virtual
Hard Disk Drives

Procedure

1. Prepare Adobe Reader.

For details, see Preparing Adobe Reader on page 3-5

2. Modify the environment of the virtual machine image.

For details, see Modifying the Virtual Machine Environment on page 3-6.

3. Export the virtual machine image.

For details, see Exporting Virtual Machine Images on page 3-16.

4. Convert the virtual hard disk drive of the exported image to the VirtualBox format.

For details, see Converting VMware ESXi Virtual Hard Disk Drives on page 3-23.

5. Create a new virtual machine image using the converted virtual hard disk drive.

For details, see Creating Virtual Machine Images Using Converted Virtual Hard Disk
Drives on page 3-30.

6. Configure the new virtual machine image.

For details, see Configuring Virtual Machine Images on page 3-46.

7. Export the virtual machine image to an OVA file.

For details, see Exporting Virtual Machine Images to OVA Files on page 3-51.

Required Software

The following software must be installed on the virtual machine to achieve satisfactory
detection results.
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Table 3-1. Required Applications

Software Description

Operating system Virtual Analyzer supports the following operating systems:

• Windows XP

• Windows 7

• Windows 8/8.1

• Windows 10 RS3 and before

• Windows Server 2003/2003 R2

• Windows Server 2008/2008 R2

• Windows Server 2012/2012 R2

• Windows Server 2016

Important

• Package the installer as an ISO file.

• Activate Windows with a valid product key after the
Virtual Analyzer Image Preparation Tool has validated
and modified virtual machine settings. Do not activate
Windows before that.

• Use a computer name that reflects your organizations'
naming scheme.

• Disable automatic updates.

• Trend Micro recommends using the English version of
the listed operating systems.
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Software Description

Office suite Virtual Analyzer supports the following office suites:

• Office 2003 (32-bit)

• Office 2007 (32-bit)

• Office 2010 (32-bit and 64-bit)

• Office 2013 (32-bit and 64-bit)

• Office 2016 (32-bit and 64-bit)

• Office 365 (32-bit and 64-bit)

Important

• Microsoft Word, Microsoft Excel, Microsoft PowerPoint,
and Microsoft Publisher must be installed.

• Activate Microsoft Office with a valid product key after
the Virtual Analyzer Image Preparation Tool has
validated and modified virtual machine settings. Do not
activate Microsoft Office before that.

• After installation, open all Microsoft Office applications
and verify that the main editing screen is displayed. If
any confirmation dialog or welcome screen displays,
make any selection to close the screen and display the
main editing screen.

Figure 3-1. Help Protect and Improve Microsoft
Office

• Verify that your license allows you to virtualize the
applications. For details, see https://support.office.com.

• Disable automatic updates.

• Enable macros. For details, see Enable or disable
macros in Office files

https://support.office.com
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
https://support.office.com/en-us/article/Enable-or-disable-macros-in-Office-files-12b036fd-d140-4e74-b45e-16fed1a7e5c6
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Software Description

Adobe Reader Install the version of Adobe Reader that is most widely used in
your organization. To download the most current version of Adobe
Reader, go to http://www.adobe.com/downloads/.

If you do not install Adobe Reader, Virtual Analyzer:

• Installs Adobe Reader 8, 9, and 11 on all Windows XP and
Windows Server 2003/2003 R2 images during importing.

• Installs Adobe Reader 9, 11, and DC on all Windows 7 and
newer images during import.

• Uses all versions during analysis.

WARNING!
This consumes additional computing resources.

• Installs .NET Framework 3.5 or later if the operating system
is Windows XP or Windows Server 2003.

Configure Adobe Reader to manually check for and install
updates. For details, see https://helpx.adobe.com/acrobat/kb/
reader-acrobat-updater-settings.html.

Important

Do not install VMware tools to avoid triggering the anti-virtual machine functions of some
malware.

Preparing Adobe Reader

Perform the following steps if Adobe Reader is installed on the virtual machine.

Procedure

1. Disable automatic updates.

For details, see http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-
acrobat-reader.html.

http://www.adobe.com/downloads/
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
https://helpx.adobe.com/acrobat/kb/reader-acrobat-updater-settings.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
http://helpx.adobe.com/acrobat/kb/disable-automaticupdates-acrobat-reader.html
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2. Install the necessary Adobe Reader language packs so that Virtual Analyzer can
process files authored in languages other than those supported in your native
Adobe Reader.

For example, if you use the English version of Adobe Reader and you expect to
analyze files authored in East Asian languages, install the Asian and Extended
Language Pack.

3. Start Adobe Reader.

Important

Perform this step before exporting the virtual machine.

Modifying the Virtual Machine Environment

Modify the virtual machine environment to run Virtual Analyzer Sensors, a collection of
utilities that execute and detect malware, and record all behavior in Virtual Analyzer.

• Modifying the Virtual Machine Environment (Windows XP and Windows Server 2003) on
page 3-6

• Modifying the Virtual Machine Environment (Windows 7/8/8.1/10, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2 and Windows Server 2016) on page 3-9

• Uninstalling VMware Tools on page 3-14

Modifying the Virtual Machine Environment (Windows XP
and Windows Server 2003)

Procedure

1. Open a Command Prompt window (cmd.exe) using an account with
administrator privileges.

2. Perform the following tasks:
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Task Steps

Set the "Administrator"
logon password to "1111".

Type net user "Administrator" 1111.

Configure automatic logon
from the “Administrator”
account.

Note
The logon prompt is
bypassed and the
“Administrator”
account is
automatically used
to log on to the
system every time
the virtual machine
starts.

a. Type the following commands:

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
REG_SZ /d Administrator /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_SZ /d 1111 /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v AutoAdminLogon /t
REG_SZ /d 1 /f

b. Restart the image.
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Task Steps

Note
No logon prompt is displayed and the
“Administrator” account is automatically used to
log on.

Figure 3-2. Windows XP Administrator
Account

View all user accounts. Type net user.

Delete non-built-in user
accounts one at a time.

Type net user “<username>” /delete.

Example: net user “test” /delete

View all network adapters
with an active link

Type wmic nic where "netconnectionstatus=2"
get netconnectionid /value.
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Task Steps
Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of
all installed network
adapters

Type netsh interface ip show config.

The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Disable Windows Firewall. Type netsh firewall set opmode mode=DISABLE.

Note
Windows Firewall slows down the installation of
Virtual Analyzer Sensors.

Uninstall VMware Tools. For details, see Uninstalling VMware Tools on page
3-14.

3. Restart the virtual machine.

Modifying the Virtual Machine Environment (Windows
7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016)

Procedure

1. Open a Command Prompt window (cmd.exe) using an account with
administrator privileges.

2. Perform the following tasks:



Virtual Analyzer Image Preparation Tool User's Guide   

3-10   

Task Steps

Enable the “Administrator”
account.

Type net user “Administrator” /active:yes.

Set the logon password
for the “Administrator”
account to “1111”.

Type net user "Administrator" 1111.

Configure automatic logon
from the administrator
account.

Note
Each time the
image starts, the
logon prompt is
bypassed and the
“Administrator”
account is
automatically used
to log on to the
system.

a. Type the following commands:

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultUserName /t
REG_SZ /d Administrator /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v DefaultPassword /t
REG_SZ /d 1111 /f

• REG ADD "HKEY_LOCAL_MACHINE\SOFTWARE
\Microsoft\Windows NT\CurrentVersion
\Winlogon" /v AutoAdminLogon /t
REG_SZ /d 1 /f
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Task Steps

Note
In Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2 and
Windows Server 2016, launch the
Local Security Policy snap-in
(secpol.msc) to disable the Password
must meet complexity requirements
Local Security Setting.

Figure 3-3. Disable Password must
meet complexity requirements

• Restart the image.
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Task Steps
No logon prompt is displayed and the
“Administrator” account is automatically used
to log on.

Figure 3-4. Windows 7 Administrator
Account

View all user accounts. Type net user.

Delete non-built-in user
accounts one at a time.

Type net user “<username>” /delete.

Example: net user “test” /delete

View all network adapters
with an active link

Type wmic nic where "netconnectionstatus=2"
get netconnectionid /value.

Example output: NetConnctionID=Local Area
Connection

Verify the DHCP status of
all installed network
adapters

Type netsh interface ip show config.
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Task Steps
The configuration of all installed network adapters
displays. Verify that the value for DHCP enabled: is
Yes.

Configure a network
adapter to use DHCP

Type netsh interface ip set address
name="<network adapter>" dhcp.

Example: netsh interface ip set address
name="Local Area Connection" dhcp

Configure AutoPlay a. Open the Windows Start menu, type Control
Panel into the search box and press ENTER.

b. In the Control Panel, go to Hardware and Sound
> AutoPlay.

Figure 3-5. AutoPlay

c. For Software and games, select Install or run
program from your media.

d. Click Save.

Disable Windows Firewall. Type netsh advfirewall set allprofiles state
off.

Note
Windows Firewall slows down the installation of
Virtual Analyzer Sensors.
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Task Steps

Uninstall VMware Tools. For details, see Uninstalling VMware Tools on page
3-14.

3. Restart the virtual machine.

Uninstalling VMware Tools
VMware Tools will attempt to connect to a VMware ESXi host, which might prevent
VirtualBox from importing the virtual machine image.

Procedure

1. Go to Start > Control Panel.

The Control Panel screen appears.

2. Check the list of installed programs.

• Windows XP and Windows Server 2003: Click Add or Remove Programs.

• Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: Click Programs and Features.
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A list of installed programs appears.

Figure 3-6. Add or Remove Programs (Windows XP)
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Figure 3-7. Add or Remove Programs (Windows 7)

3. Select VMware Tools and then click Remove (Windows XP or Windows Server
2003) or Uninstall (Windows 7/8/8.1/10, Windows Server 2008/2008 R2,
Windows Server 2012/2012 R2 or Windows Server 2016).

4. Click Yes to uninstall VMware Tools.

5. Click Yes to restart Windows.

VMware Tools is uninstalled.

Exporting Virtual Machine Images

You must verify and modify some settings before exporting a virtual machine image
from VMware ESXi or Workstation.

• Verifying Virtual Machine Settings on VMware Workstation on page 3-17
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• Exporting Virtual Machine Images on VMware ESXi on page 3-19

• Converting VMware ESXi Virtual Hard Disk Drives on page 3-23

Verifying Virtual Machine Settings on VMware Workstation

Procedure

1. Shut down the virtual machine.

2. In the left pane, right-click the virtual machine and then select Settings.

The Virtual Machine Settings screen appears.

Figure 3-8. Virtual Machine Settings

3. On the Hardware tab, verify the following:

• CD/DVD (IDE): Connection is Use physical drive.

• Floppy: Connection is Use physical drive.
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Figure 3-9. Virtual Machine Settings - Hardware

4. Go to the Options tab and then click General.

5. In the right pane, under Working directory, locate the Virtual Machine Disk
(*.vmdk).
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Figure 3-10. Working Directory

Exporting Virtual Machine Images on VMware ESXi

Procedure

1. Shut down the virtual machine.

2. In the left pane, right-click the virtual machine and then select Edit Settings.
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Figure 3-11. Edit Settings

The Virtual Machine Properties screen appears.

3. On the Hardware tab, verify the following settings:

• CD/DVD drive 1: Client Device

• Floppy drive 1: Client Device
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Figure 3-12. Virtual Machine Properties - Hardware

4. In the left pane, select the virtual machine and then go to File > Export > Export
OVF Template.
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Figure 3-13. OVF Template

The Export OVF Template screen appears.

5. Configure the following settings:

• Name: Type a name for the virtual machine image.

Note

(Optional) Click the folder icon to change the path of the OVF template files.

• Format: Select Folder of files (OVF).

Important

Verify that Include image files attached to floppy and CD/DVD devices in the
OVF package is not selected.

6. Click OK.
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Converting VMware ESXi Virtual Hard Disk Drives
VirtualBox does not support the virtual hard disk drive format (*.vmdk) of VMware
ESXi images. Use one of the following tools to convert the disks:

• Using VMware vCenter Converter Standalone on page 3-23

• Using QEMU on page 3-29

Using VMware vCenter Converter Standalone

Procedure

1. Download VMware vCenter Converter Standalone from https://
my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/
vmware_vcenter_converter_standalone/5_5#product_downloads.

Note
VMware vCenter Converter Standalone 5.0 does not support vCenter Server and
ESXi versions later than 5.0. Download and install a version later than 5.0.1.

2. Open VMware vCenter Converter Standalone and then click Convert machine.

https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
https://my.vmware.com/web/vmware/info/slug/infrastructure_operations_management/vmware_vcenter_converter_standalone/5_5#product_downloads
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Figure 3-14. VMware vCenter Converter Standalone

The Conversion window opens.

3. On the Source System screen, configure the following:

a. Select source type: Select VMware Infrastructure virtual machine.

b. Server: Type the ESXi server IP address.

c. User name, Password: Type the credentials that provide administrator access
to the VMware server.

4. Click Next.
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The Source Machine screen appears.

Figure 3-15. Conversion > Source Machine

5. Select the virtual machine that you want to convert and then click Next.
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The Destination System section appears.

Figure 3-16. Conversion > Destination System

6. Configure the following and then click Next.

a. Select destination type: Select VMware Workstation or other VMware
virtual machine.

b. Select VMware product: Select VMware Workstation 6.5.x.

c. Virtual machine details: Accept the default name and location or click
Browse to select a different file.
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The Options screen appears.

Figure 3-17. Conversion > Options

7. Verify the settings and then click Next.

Important
Verify that Install VMware Tools is set to No.

The Summary screen appears.
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Figure 3-18. Conversion > Summary

8. Verify the information and then click Finish.
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VMware vCenter Converter Standalone converts the Virtual Machine Disk (*.vmdk).

Figure 3-19. Image Conversion Progress

Using QEMU

For details on QEMU, see http://wiki.qemu.org/Main_Page.

Procedure

1. Download the latest version of QEMU from http://qemu.weilnetz.de/w64/.

2. Install QEMU with the default settings.

3. Open a Command Prompt window (cmd.exe) using an account with
administrator privileges.

4. Convert the Virtual Machine Disk (*.vmdk) by typing the following command:

qemu-img.exe convert [-f fmt] [-O output_fmt] filename
output_filename.

http://wiki.qemu.org/Main_Page
http://qemu.weilnetz.de/w64/
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For example:

"C:\Program Files\qemu\qemu-img.exe" convert -f vmdk -O vmdk 
C:\ESX_xpsp3en_offices_noab.vmdk C:\ESX_xpsp3en_offices_noab_converted.vmdk

The *.vmdk file can be used to create an OVA file using VirtualBox.

Creating Virtual Machine Images Using Converted Virtual
Hard Disk Drives

Use VirtualBox to create a new virtual machine image.

• Downloading and Installing VirtualBox on page 2-5

• Creating Virtual Machine Images Using VirtualBox on page 3-31

Downloading and Installing VirtualBox

Procedure

1. Download the latest version of VirtualBox from https://www.virtualbox.org/wiki/
Downloads.

Note

The VirtualBox Open Source Edition is licensed under the GPL V2. The full text of
the license is available at http://www.gnu.org/licenses/old-licenses/gpl-2.0.html.

2. Configure the language settings using one of the following methods:

• Install VirtualBox with English as the default language.

• After installation, go to File > Preferences > Language and then select
English.

https://www.virtualbox.org/wiki/Downloads
https://www.virtualbox.org/wiki/Downloads
http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
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Figure 3-20. Language Settings

Creating Virtual Machine Images Using VirtualBox

Procedure

1. Open VirtualBox.
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The VirtualBox Manager window opens.

Figure 3-21. VirtualBox Manager

2. Click New.
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The Create Virtual Machine window opens.

Figure 3-22. Create Virtual Machine

3. On the Name and operating system screen, configure the following:

• Name: Type a permanent name for the virtual machine.

• Type: Select Microsoft Windows.

• Version: Select Windows XP, Windows 2003, Windows 7, Windows 8,
Windows 8.1, Windows 10, Windows 2008/2008 R2, Windows 2012/2012
R2 or Windows 2016.
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4. Click Next.

The Memory size screen appears.

Figure 3-23. Memory Size

5. Specify the recommended memory size for your operating system.

• Windows XP and Windows Server 2003: 512 MB

• Windows 7/8/8.1/10, Windows Server 2008/2008 R2, Windows Server
2012/2012 R2 and Windows Server 2016: 1024 MB

6. Click Next.
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The Hard disk screen appears.

Figure 3-24. Hard Disk

7. Select Do not add a virtual hard disk and then click Create.
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The following message appears:

Figure 3-25. Warning

8. Click Continue.
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VirtualBox creates the virtual machine. The new virtual machine appears in the left
pane.

Figure 3-26. Newly-created Virtual Machine

9. Click Settings.
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The Settings window opens.

Figure 3-27. VirtualBox Settings

10. In the left pane, click System.
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The System screen appears.

Figure 3-28. System Screen

11. On the Motherboard tab, configure the following:

• Chipset: Select ICH9.

• Pointing Device: Select USB Tablet.

• Extended Features: Select Enable I/O APIC.

12. Go to the Processor tab and then select Enable PAE/NX.

13. Go to the Acceleration tab and then select Enable VT-x/AMD-V and Enable
Nested Paging.
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Note

The Acceleration tab is only available if the processor of the host system supports
virtualization technology and the virtualization setting is enabled in the BIOS of the
host system.

14. In the left pane, click Storage.

The Storage screen appears.

Figure 3-29. Storage Screen

15. If Controller: SATA appears under Storage Tree, remove the SATA controller
and then add the virtual hard drive to the IDE controller.

a. Click Controller: SATA and then click  to remove the default controller.

b. Click Controller: IDE and then click .
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The following message appears:

Figure 3-30. Choose Existing Disk

c. Click Choose existing disk and then select the converted *.vmdk file.

d. Under Attributes, retain all default settings.

e. Under Storage Tree, click Controller: IDE and then click the empty optical
drive icon.

f. Under Attributes, verify that CD/DVD Drive is IDE Secondary Master.
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Figure 3-31. IDE Secondary Master

16. (Optional) In the left pane, click Audio and verify that Enable Audio is enabled.
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Figure 3-32. Audio Options Settings

17. In the left pane, click USB and then select Enable USB Controller.

Important
Verify that USB 1.1 (OHCI) Controller is selected.
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Figure 3-33. Enable USB Controller

18. In the left pane, click Shared Folders and then verify that no folders are shared.
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Figure 3-34. Shared Folders Settings

19. Click OK.

The Settings window closes.

20. On the VirtualBox Manager screen, click  to power on the image.
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Figure 3-35. VirtualBox Manager

21. Install Microsoft Office and other software to achieve satisfactory detection results.

Configuring Virtual Machine Images
Configure virtual machine images that were created using converted virtual hard disk
drives to avoid importing issues.

• Configuring Virtual Machine Images (Windows XP and Windows Server 2003) on page 3-47

• Configuring Virtual Machine Images (Windows 7/8/8.1/10, Windows Server 2008/2008
R2, Windows Server 2012/2012 R2 and Windows Server 2016) on page 3-50
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Configuring Virtual Machine Images (Windows XP and
Windows Server 2003)

Procedure

1. On the guest operating system, click Start, right-click My Computer, and then
click Manage.

The Computer Management screen appears.

Figure 3-36. Computer Management

2. In the left pane, click Device Manager.
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A list of devices appears.

Figure 3-37. Device Management - Network Adapter Window

3. In the right pane, click Network adapters and then verify that the network
adapter driver is ready.

4. Open a Command Prompt window (cmd.exe) using an account with
administrator privileges.

5. Disable the Found New Hardware Wizard by typing the following commands:

• Windows XP 32-bit:

reg add "HKEY_LOCAL_MACHINE\Software\Policies\Microsoft
\Windows\DeviceInstall\Settings" /v SuppressNewHWUI /t
REG_DWORD /d 1 /f

• Windows XP 64-bit or Windows Server 2003:
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reg add "HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet
\Services\PlugPlay\Parameters" /v SuppressUI /t
REG_DWORD /d 1 /f

Figure 3-38. Found New Hardware Wizard

6. Restart the image and then verify that the Found New Hardware Wizard does
not appear.

7. Power off the image.
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Configuring Virtual Machine Images (Windows 7/8/8.1/10,
Windows Server 2008/2008 R2, Windows Server 2012/2012
R2 and Windows Server 2016)

Procedure

1. On the guest operating system, click Start, right-click Computer, and then click
Manage.

The Computer Management screen appears.

Figure 3-39. Computer Management

2. In the left pane, click Device Manager.
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A list of devices appears.

Figure 3-40. Device Management - Network Adapter

3. In the right pane, click Network adapters and then verify that the network
adapter driver is ready.

4. Power off the image.

Exporting Virtual Machine Images to OVA Files
A virtual machine image comprises many uncompressed files. The files must be
combined into a single OVA file to avoid issues when importing.

Important
Verify that the size of the created OVA file is supported by your product.

For details, go to https://docs.trendmicro.com/en-us/home.aspx#Enterprise.

https://docs.trendmicro.com/en-us/home.aspx#Enterprise
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Procedure

1. On the VirtualBox Manager screen, power off the virtual machine.

Note

Verify that the CD/DVD drive is empty before powering off and exporting.

2. Go to File > Export Appliance.

The Export Virtual Appliance window appears.

Figure 3-41. Export Virtual Appliance

3. Select the virtual machine image to export and click Next.
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The Storage settings screen appears.

Figure 3-42. Storage settings

4. Configure the following:

• File: Accept the default name and path or click  to select a different file.

• Format: Select OVF 1.0.

Important

Format options include OVF 0.9, 1.0 and 2.0. Virtual Analyzer does not
support OVF 2.0.

5. Click Next.
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The Appliance settings screen appears.

Figure 3-43. Appliance settings

6. Verify that the License field is empty and then click Export.
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VirtualBox creates the OVA file.

Figure 3-44. Disk Image Export Progress Bar
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Chapter 4

Virtual Analyzer Image Preparation
Tool

Learn how to use the Virtual Analyzer Image Preparation Tool in the following topics:

• Overview on page 4-2

• Image Validation and Configuration on page 4-4

• System Requirements on page 4-3

• Using the Tool on page 4-5

• Troubleshooting Common Issues on page 4-20
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Overview
The Virtual Analyzer Image Preparation Tool facilitates the creation of custom sandbox
images.

Table 4-1. Features

Feature Description

Image creation Create custom sandbox images for the following products:

• Deep Discovery Inspector 3.8 and later

• Deep Discovery Email Inspector 2.1 and later

• Deep Discovery Analyzer 5.1 and later

• TippingPoint Advanced Threat Protection for Networks 3.8
SP2 and later

• TippingPoint Advanced Threat Protection for Email 2.5 and
later

• TippingPoint Advanced Threat Protection Analyzer 5.5 and
later

• Deep Discovery Director 1.1 and later

• Deep Discovery Web Inspector 2.0 and later

Image validation
and configuration

The tool validates and configures OVA files created using
VirtualBox.

Note
For images created using VMware, see OVA File Creation
Using Converted Virtual Hard Disk Drives on page 3-1.
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System Requirements
Table 4-2. System requirements

Requirement Specification

Host operating
system

Build 3.8.1009 and later:

• Windows 7 (32-bit and 64-bit)

• Windows 8 (32-bit and 64-bit)

• Windows 8.1 (32-bit and 64-bit)

• Windows 10 (32-bit and 64-bit)

Build 3.8.1240 and later:

• Windows Server 2003/2003 R2

• Windows Server 2008/2008 R2

• Windows Server 2012/2012 R2

Important
Microsoft .NET Framework 4.0 or later must be installed on
the host operating system.

Virtualization
application

Oracle™ VM VirtualBox 4.3 or later (except 5.0.6)

Important
The tool does not support VirtualBox 5.0.6 because a
defect prevents the first serial port from functioning
properly. Trend Micro recommends using VirtualBox 5.0.7
or later.

For virtual machine images created in VMware, see
Creating OVA Files Using Converted Virtual Hard Disk
Drives on page 3-2.
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Requirement Specification

Hardware
virtualization

The hardware virtualization in the motherboard BIOS of the host
operating system must be enabled to support Windows 8/8.1/10
or any 64-bit guest operating systems.

Note
The tool can detect hardware virtualization only on
Windows 8/8.1/10 hosts.

Image Validation and Configuration
The tool automatically validates and configures the following VirtualBox image settings.

Table 4-3. Validating and configuring image settings

Setting Correct Configuration

Admin password 1111

Keyboard layout Enhanced keyboard layout: 101

Found New Hardware
Wizard

Disabled

Disk defragmentation Disabled

.NET Optimization Disabled

CPU count 1

Memory size • Windows XP or Windows Server 2003: 512 MB

• Other operating systems: 1024 MB

PAE/NX Enabled

Hardware virtualization VT-x/AMD-V and nested paging enabled

Audio driver Enabled
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Setting Correct Configuration

Windows SMB service
(TCP port 445)

Enabled

File and Printer Sharing for
Microsoft Networks

Enabled

AutoPlay Enabled in Windows 7/8/8.1/10

Microsoft Office macros Enabled

Network adapter settings Obtain an IP address automatically

Important
The tool checks but does not modify the Windows and Office versions. Verify that the
image meets the requirements before running the tool.

Using the Tool

Procedure

1. Obtain a copy of SandboxWizard.zip from your support provider.

2. Extract the package content to a local folder. Go to the folder and then open
SandboxWizard.exe.
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The introduction screen appears.

Figure 4-1. Introduction screen

3. Click Next.

The tool checks if the computer meets the system requirements, and then the
System Requirements screen appears.
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Figure 4-2. System Requirements screen

4. Click Next.



Virtual Analyzer Image Preparation Tool User's Guide   

4-8   

The Specify Virtual Machine screen appears.

Figure 4-3. Specify Virtual Machine screen

5. Specify an OVA file or a virtual machine instance running on VirtualBox.

a. Select one of the following:

• Use an OVA image (exported from VirtualBox): Select this option if
you converted a VMware image and then packaged it as an OVA file. For
details, see OVA File Creation Using Converted Virtual Hard Disk Drives on
page 3-1.
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Important
Open Virtualization Format (OVF) is a cross-platform standard for
packaging and distributing software to be run in virtual machines. OVF
enables the creation of ready-to-use software packages (operating systems
with applications) that require no configuration or installation.

An OVF package consists of several files that can be packed into a single
archive file with the extension .ova. Virtual Analyzer supports only
image files in the OVA format.

• Select a VM on VirtualBox: Select this option if you want to create an
image based on an existing virtual machine on VirtualBox.
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For example:

Figure 4-4. Specify Virtual Machine screen - Select a VM on
VirtualBox

b. Select Clone VM before processing to create a new copy of the virtual
machine with its own set of individual snapshots. Cloning allows quick
creation of duplicate environments for testing. You can run as many clones as
the memory and processors on the system allow.

6. Click Next.
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The Sandbox Preparation screen appears.

Figure 4-5. Sandbox Preparation screen

The tool modifies incorrectly configured settings. For a list of settings that the tool
validates, see Image Validation and Configuration on page 4-4. For solutions to issues
that occur during this phase, see Troubleshooting Common Issues on page 4-20.

7. Perform one of the following actions depending on the screen that appears:
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• The Sandbox Ready screen appears when the tool has successfully validated
and configured all settings.

Figure 4-6. Sandbox Ready screen

Click Next to continue.
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• The Products Not Activated screen appears when the tool detects that
Windows and/or Office are installed but not activated.

Figure 4-7. Products Not Activated screen
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Click How to activate products to learn to how to activate Windows and/or
Office in the guest operating system.

Figure 4-8. How to activate products dialog

Click Retry after activating the products, or click Next to continue without
activating the products. It is recommended to activate the products in the
guest operating system to ensure normal operation of the image.
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• The Sandbox Preparation Unsuccessful screen appears when the tool is
unable to fix issues encountered during preparation.

Figure 4-9. Sandbox Preparation Unsuccessful screen

Click View detailed log and perform any recommended actions before
running the tool again.

Click Retry to try preparing the sandbox again, or Cancel to exit the tool.
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If no issues arise, the Specify the OVA image path and file name screen
appears.

Figure 4-10. Specify OVA image path and file name screen

If issues arise and are not resolved, see Troubleshooting Common Issues on page 4-20.
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Note

SandboxWizard.exe saves logs in the \log folder where you run the tool. Logs
use the following naming convention: d:\SandboxWizard\log\VATool-
yyyymmddhhmmss_output.txt

For example: d:\SandboxWizard\log
\VATool-20170925025520_output.txt

8. Configure the following settings:

• Specify the path and file name that the tool uses when saving the OVA file.

Note

The tool uses the following naming convention when saving an OVA file:
VATool-20170925025520.ova

• (Optional) Enable Remove the image from VirtualBox after exporting.

Disable this option if you want to keep the image in VirtualBox even after
exporting.

Important

Unused images consume valuable disk space may impact performance.

• (Optional) Enable Compress the image for uploading to Deep Discovery
Director.

Important

Only Virtual Analyzer images compressed in TAR format by the Virtual
Analyzer Image Preparation Tool can be uploaded to and deployed from Deep
Discovery Director.

9. Click Next.



Virtual Analyzer Image Preparation Tool User's Guide   

4-18   

The Export the image to OVA screen appears and the tool exports the OVA file.

Figure 4-11. Export the image to OVA screen
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The OVA Image Ready screen appears when the export process completes.

Figure 4-12. OVA Image Ready screen

10. Click the Close button in the upper right corner to exit the tool or click Back to
Home to create another image.
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Troubleshooting Common Issues
Table 4-4. Common Issues When Using the Tool

Issue Cause Recommended Action

Unable to upload an
OVA file.

The image does not
meet the minimum
or maximum size
requirements.

Verify that the size of the OVA file is
supported by your product.

Unable to prepare a
virtual machine
image.

The image was not
created using
VirtualBox.

Install a supported VirtualBox version. For
details, see System Requirements on page
4-3.

For virtual machine images created in
VMware, see Creating OVA Files Using
Converted Virtual Hard Disk Drives on
page 3-2.

VirtualBox is not
installed on the
computer.

The image uses an
unsupported
operating system.

Use a supported operating system. For
details, see Required Software on page
2-2.

VirtualBox is
unresponsive.

Refer to the VirtualBox documentation.

https://www.virtualbox.org/manual/
ch12.html#idp54271008

https://www.virtualbox.org/manual/ch12.html#idp54271008
https://www.virtualbox.org/manual/ch12.html#idp54271008
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Issue Cause Recommended Action

Unable to start the
VirtualBox
installation CD/
DVD.

Settings are
incorrectly
configured.

Open the imported image using VirtualBox
and verify the following Storage settings.

• Select Controller: IDE and verify that
the specified type is PIIX4.

Figure 4-13. Controller: IDE must
be set to PIIX4

• Select the optical disc icon and verify
that the specified CD/DVD drive is
IDE Secondary Master.

Figure 4-14. CD/DVD drive is set to
IDE Secondary Master
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Issue Cause Recommended Action

Unable to enter the
desktop of the guest
operating system.

Group policy
settings are
incorrectly
configured.

Click OK on the Virtual Analyzer Image
Preparation Tool Test screen to enter the
desktop of the guest operating system.
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Issue Cause Recommended Action

Unable to start
SandboxWizard.exe
in the guest image.

AutoPlay settings
are incorrectly
configured.

1. Open VirtualBox.

2. On the VirtualBox Manager screen,

click  to power on the image.

3. On the guest operating system,
perform the following:

a. Go to Control Panel > Hardware
and Sound > AutoPlay.

b. Select Install or run program
from your media from the
Software and games drop-down
menu.

c. Click Save.

d. Open the Local Group Policy
Editor.

e. Go to Computer Configuration >
Administrative Templates >
Windows Components >
AutoPlay Policies.

f. Select Not configured to disable
AutoPlay.
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Sample Logs
Preparation successful. Missing app detected.
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Preparation unsuccessful. Some items must be fixed manually.
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